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About Flip PDF

Flip PDF is your easy way to batch convert ordinary
PDF files into stunning booklets with amazing
page-flipping animations and sound! Imagine
being able to create digital magazines and
catalogues that behave like actual paper books
without any programming work! Once vyou've
created your page-flipping masterpiece in Flip PDF,
you can publish it to the web, via email, and even
distribute it on CD-ROM, all without paying

royalties!

Note: This product is distributed on a "Try
before-you-buy" basis. All features described in this
documentation are enabled. The registered version
doesn't insert a watermark in your generated

page-flipping eBooks.
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Product features

10.
11.

12.

Convert PDF to Adobe®© Flash® based page-flipping eBooks.

Batch convert multiple PDF files to a single or multiple page-flipping
eBooks.

Import bookmarks (outline/table of content) with PDF.

Import hyperlinks with PDF, include web link, page link, email link.

Import text so text is searchable, define the minimum search characters.
Add watermarks text, image, dynamic date/ time etc to page-flipping
eBooks.

Define quality and size for normal version and mobile version.

Output to different formats: HTML, EXE, Zip, Mac App, Mobile version and
Burn to CD.

o HTML allows you to upload to a website to be viewed online (with title,
keywords and other metadata defined).

o EXE (with setting title, icon and open window size) and Zip allow you to
send to your user by email to be viewed on their computer.

o App (Mac Application) is executable application can be run on Mac.

o Mobile version is to output HTML flipbook which can be viewed on
mobile devices via Browsers.

o Burn to CD allows you to burn to disk so you can send your user physical
media for viewing on their computer.

Apply a pre-designed template.

Preview the output effect instantly.

Add HTML Title in Float template which can be clicked to visit webpage
online.

Add Image or Flash logo to insert before Book Title in Float template.
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13

14.
15.

16.

17.
18.
19.
20.
21.

22.
23.
24,

25.
26.
27.

28.
29.

30.
31.

. Define book proportions, margin size, shadow manually.

Set background color and image.

Insert background music either for continuous play (loop) or for a set
duration.

Set eBook reading from right to left (for Right-to-Left languages such as
Arabic).

Choose hard cover for eBooks.

Set fonts for Flash and Bookmark, Search panel.

Define the language for your published page-flipping eBook.

Add password to protect your page-flipping eBook.

Different kinds of render engine for choice to avoid distortion for some
special PDF files: SWF, GPL Ghostscript or Inner Library.

Google Analytics Support.

Set colors and position (Top/Bottom) for toolbar.

Set permissions for downloading, printing, social sharing, Home button
and more.

Add watermark image or SWF to show on print out pages.

Add Help config to manually define content with using Image or SWF.

Set Page Number Box to show at top or bottom in Float, set start page
number.

Add Minime Style to show page-flipping eBooks without toolbar.

Edit bookmark manually and set bookmark panel to show on left or right
side.

Export and save settings for future uses.

Save and Load your project.
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Page-flipping eBook features

With the page-flipping ebook you have created, your user will be able to:

1.

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

Drag the corner to flip a page.

Click page shadows to flip a page.
Use mouse wheel to flip pages.

Input password to unlock encrypted pages.

View with important pages pre-loaded to open quickly, no need to wait for
all pages to be loaded.

Use Previous, Next, First or Last buttons to navigate through the pages.

Flip pages automatically.

View flipbook repeatedly.

View page-flipping eBook full screen.

Use page thumbnails to navigate.

Search whole eBook.

Print out the whole eBook or a selected range of pages.

Download the uploaded page-flipping eBook direct from the web site.
Double-click to zoom in or zoom out.

Zoom in/ out both pages.

Manually control zoom in scale in Float template.

Share eBook URL via email, Facebook, Twitter, Google, Yahoo, etc.

Turn page-turning sound on/off

Open in the Browser to a specific page by adding a page index to your URL.

E.G. www.yourdomain.com/index.html?pagelndex=4.

Always show in Minime Style with adding a parameter to URL. E.G.
www.yourdomain.com/index.html?alwaysMinimeStyle=true.

View page-flipping eBooks on Mac, iPad, iPhone and Android devices.
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Quick Start

1. Launch the application via the desktop shortcut =i,

2. Click the "Import PDF" icon W 10 enter into Import PDF interface;
3. Click icon to choose PDF file from your computer;

4. Click ImPertlow [;-q to enter into template setting interface;

5. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and

then click the "Apply Change" icon ;
EX)

6. Click "Convert to Flipping Book" icon to enter into Output

interface;

7. Choose Output Type from HTML, ZIP and EXE, here take

\c::_? @ = html
as example;

8. Click to set Output Folder as "C:\flipbook", input File Name

as "demo";

9. At last, click MJ icon to output created page-flipping eBook.

You can open the "flipbook" folder in "C:", there are three files in this folder:

5 @

files book.swf demo.html
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Open the "demo.html" file to view your created pOOage-flipping book via Web
Browser, such as Internet Explorer, Google Chrome, Firefox, etc.

@ demo - Windows Intemet Explorer = | & ||
@O & Caflipbockideme html ~[ 42| x ||[= 8ing £ -.\
i Favorites | ol

|§dﬁm° ‘_| - - [ @ v Pagev Safety~ Tools~ @~

FLir PDF

€ Internet | Protected Mode: Off fy v B100% ¥

Interfaces

There are some main interfaces you will see while using Flip PDF as
below shows: Application Options, Import PDF, Template Settings,
Language Option, Output, and Batch Convert.

You can enter into each page to get clear instructions for every detail

option.
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I. Application Options Interface

1. Render Engine Option

Flip PDF provides 3 different render engines for you to create higher quality
page-flipping eBooks, click "Options->Application Options" to enter into "Render

Engine" interface:

Randar Engne

Please selecte a render engine for the conversion

i
SWF
F

GPL Ghestscript Digwdoad Ghostscrion

F

@ [rner Lirary

SWF: Much legible characters, smaler output size
GPL Ghostsaipt: Higher color ransfer quality

Inner Library: Faster convert speed

SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality
Inner Library: Faster convert speed

(Change option when PDF imported failed)

2. Create Mobile Version Option

Five types of "Pages Quality And Size" for mobile version eBooks:

: Pages Quality and Size

Quality And Size:

i |
High quality large file size
Medium quality medium file size
Low quality small file size
Lower quality smaller file size

High values ¢
* butrequire m
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Il. Import PDF Interface

ﬁ. Import PijF lﬁ X

Source PDF Flie

-+ \Useful Documents\PDFs\Flip PDF.pdf Browse.. | | Qpen it |
The Page Ranges to Import Watermark

© All pages Ll g Place a custom text or image

@ Giistomrange: [1-10 : nlei1.3,5.971 [ Watermark(Stamp) to the file(s)

7

[¥] Quickly import (Only import 10 pages to initial preview) | Set Watermark |
Page Quality

Quality And Size: |Medium quality medium file size - |

M High values produce better page quality but require more disk space and more time to download,

[¥] Import bookmark [#] 1mport links [¥] Enable search

[mportwow] [ conci ]

1. Source PDF File
Click this icon to open the PDF file you want to convert;

Qpen it View content of added PDF file to clarify before converting.

2. The Page Ranges to Import

© &ll pages Convert all pages to page-flipping eBook;

@ Custo A E ie51,3,5:9-21 .
i e Convert defined range page;

[¥] Quickly import (Only import 10 pages to initial preview) Just preview effect on first 10 pages

3. Watermark
Add image or text watermark to flipping pages.

il ing Wi . -
[l Applying Watermark Check this option first to choose default stamps or add new ones:
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[ Add Text Watermark et

& Add Text Watermark
Textame
lome:  Text Watermark

Text:  Page-fippng sflock
'ex!”ﬁ!_'!_-f__

ot (@ heiveten
s

Style: |7 peid

Text Layoust

wayout [Fx

7| Tig Stre:

oo Misewld

lefi: 20

Page-flipping eBook

= =
1= =] =
TextEffect

Ogadty: 0%

Edit / p—
Add text stamp”” | ™=

Add image stamp-_§ Addimge Watemark
Add Image Watermark
Delete Inoge Name

Hame:  Image Watermark
Move down s o

3]

S ¢ X 8 &

Move up Image Propertes

wde: 0 &2 Heght: “ .
SICHRY - e

oacty: 0% 1 100%

Rotaton: 0 + gogree 1] &5 badkground

[ e sn] i Top: 20 o
n = ow S 5 5

== —

4. Page Quality
There are five types of "Quality And Size":

L LY dal HE S 2k

High guality large file size
Medium quality medium file size
Low guality small file size
Lower guality smaller file size

5. Other Options

TSI If your PDF file contains bookmarks, check this option to use in output

page-flipping eBook

Import finks If your PDF file has links, check this to enable in flipbook;

Enable search ook this option to enable search functionality in created flipbook.

At last, click icon to enter into template setting interface.

Copyright 2010 by FlipBuilder.com
-9.-



PDF to Page-Flipping eBook Utility

v by O
e TR .
= . \") User Document

lll. Template Settings Interface

File Convert Options Help
zé'i‘a Import PDF (’ Apply Change "}(;“\ Convert To Flipping Book @) Batch Convert

Wﬂhngl Bookmark |
Templates

T [ EE

Please customize the flash template here

822 Thumbnails www.FlipBuilder.com  pages: Q

[EBaock
Esound 3
ETool Bar

Initial Show | Thumbnails Fuie PDF
HLinks

Language English

Security Settings Single Password

HFont

Google Analytics ID

Start Page Numbering 0
HMinime Style

Book
'E;‘: Book Configuration

Flip PDF provides three different templates at present: Classical, Float and
Spread.
Each template contains some unique settings, the below instructions will

show you details about the default three templates.

The design setting interface contains below main parts:

Choose Template; Book; Sound; Tool Bar; Bookmark; Initial Show; Links; Language;
Security Settings; Font; Google Analytics ID; Start Page Numbering; Minime Style.

Panel Description:
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1. Choose Template

Templates

‘ Iff classical E E

Please customise the flash template here

icon to select templates from below interface:

- (More and more templates will be provided in future.)

3 Chooss a fipbook template here. (Double <click to make a quick selection)
Get More Themes Onbne

Q Click this icon is to save current settings as a TXT file for later uses;

l
Click this icon is to import stored setting file at once.

2. Book Panel

ElBook | T —
Book Title | www, FlipBuil. ..
TheBookloga ~  |CilUsersiAd...

Hide Book Frame Bar | No
_ Retain the book to center |No

_ElBookProportions |
Top Margin |10
Bottom Margin |10
Left Margin |30
RightMargin 130
Flash Window Color | I0x021A25

Page Background Color | [ 0xfffff
_BlPage Shadow

ElBackground Config |
Right To Left |Ma
Hard Cover |Ma
Flipping Time 0.6
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(1) Book Title & Book Logo (only can be set in Float Template)

Customize book title and logo for showing on the top of your flipbook. You are enabled to
set the book title as HTML format text. For example:

<a href="http://www.flipbuilder.com' target='_blank'>FLIPBUILDER.COM</a> | <font
color="#ff0000' size='14'>Red Color</font>

Bu:unl{.'l’lﬂe . <a href="..
The Book,Loga C:iUsersh...

{§ FLIPBUILDER.COM |

(2) Hide Book Frame Bar

| Hide Book Frame Bar Yes |

If don’t want to show the book frame bar, choose “Yes” in this option.

(3) Retain the book to center
| Retain the book to center |Yes -]

If you select “No” in this option, the eBook will be shown on the right-side. This setting is for

embedding special background image, such as advertisement or company log.

(4) Book Proportions

ElBook Proportions
Page Width 1052
Page Height 1500

Please note that the values are not fixed in pixels or inches, they just represent a ratio for
"Page Width: Page Height", and the book size will be changed depend on your Explorer
Window Size.

(5) Book Margin

A. Book Margin (set in Classical Template):

Copyright 2010 by FlipBuilder.com
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"Book Margin" refers to the distance between the book and the toolbar.

B. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):

Top {

Bottom 4

(6) Flash Window Color

| Flzsh Window Color | Mlox0000|

This color will be applied on all flash windows, such as the book window, "Help" window,
"Print" window and so on.

(7) Page Background Color

_ Page Background Color 140

When load pages, or if the page number of your PDF file is odd, then the page (the last page)
will show with the "Page Background Color".

Copyright 2010 by FlipBuilder.com
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(8) Page Shadow
BlPage Shadow [
Leftpage Shadow |50
Right page Shadow |28
Page Shadow Opacity  [0.5
Lefe page Shadow

Right page Shadow

The value also takes the value of Book Proportions as reference, and the value interval of
"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color.

(9) Background Config

A. Background Color:

ElBackground Config |
ElBackground Color |
Gradient Calor A | CloxFFFFFF
Gradient Color B | M 0x000000
Gradient Angle lan

Gradient Color A

el

Gradient Color B

Define background for your flipbook with gradient color or pure color (the same color for
"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between the two
colors.

B. Background Image setting in Classical and Spread templates:
ElBadckground Image | |

Image File 2

Image position

Click the icon " =J" to choose background image from your computer, and there are 11 kinds
of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right,
Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

Copyright 2010 by FlipBuilder.com
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C. Background Image setting in Float template:

EBackground Image

Outer Image File E:\Pragram.,l
Image position Scale to fit
Inner Image File E:\Program.. |

Image position |Scale to fit

The Float template enables you to add two background images: Outer Image and Inner
Image. You can make Inner background image to show special information, such as
advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to
choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle
Right, Bottom Left, Bottom Center and Bottom Right.

(10) Right to Left
If the language of your file is read from right to left (such as Arabic), then choose "Yes" in
"Right to Left" option:

|ves

(11) Hard Cover
If you want create hard cover effect (a book bound with rigid protective covers) for your

flipbook, choose "Yes" in "Hard Cover" option:

Hard Cowver |'es

Copyright 2010 by FlipBuilder.com
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(12) Flipping time

Flipping Time 0.6
Sets page flipping time in seconds according to your needs. (Recommended second value is
0.6)

3. Sound Panel

ESound
Enable Sound Enable
Sound File hple3.mp3) J
Sound Loops -1

If you want to add background sound to your flipbook, such as a song or other audio file, set
"Enable Sound->Enable", then click " =]" icon to choose "Sound File" from your computer,
then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing
flipbook, other value (N>0) stands for the times of playing the sound file.

4. Tool Bar

HTool Bar
Icon Calor (I ocfrFeFe
HZoom Config
FPrint Config
Search Button Show
Search Highlight Color MR ox408080
Least search characters |3
EDownload setting

Full Screen Button Show
[ Help Config
Sodial Share Button Shaowy

[Hshare Button

[HHome Button

Hauto Flip
Tool Bar on top. False
Page Mumber Box On Bottom|False

(1) Tool bar (only in Classical Template)

Tool bar Show Show or Hide Tool bar in created flipbook.

(2) Icon Color

Icon Color MoxFrrr =]
|| - e
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(3) Zoom Config

|:E|

ElZoom Config
Zoom in enable |Yes
Zoom Scale e

Zoom In
= S

-

To Enable Zoon In functionality, choose "Yes" in "Zoon in enable", then set "Zoom Scale", the
value is the times between zoomed page size and the current page size.

In Float template, you don't need to set Zoom Scale, you can adjust more conveniently by

the z00m in tool like this: e

(4) Print Config

ElPrint Canfig
Print Enable fes
Print Wartermark File pe.priols

Choose "Yes" in "Print Enable", you can set "Print Watermark File" to add a logo or other
kinds of watermark (image or SWF) only show in print out pages but won't show while
viewing in eBook.

Click icon to set print page range as below:

=) Print Al Pages
_J Print Current Page

| Print Range

Example; 2.5 8-26

& Print
4
(5) Search Button
| Search Button Jshow
Search Highlight Color [CJoxFFFFa0
Least search characters |3

Copyright 2010 by FlipBuilder.com
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Select "Show" in "Search Button" (make sure you have check "Enable Search" option in
"Import Word" interface), then define "Search Highlight Color" and "Least search characters",

after clicking "Search" icon , you will see a popup box to input search words, then click

Enter or "Search" button, you will get the below searching result:

(6) Download setting

ElDownload setting
Download Enable Yes |
Download URL 2DFDemo. pdf!

If you want your flipbook readers to download the PDF file or the flipbook directly from your
website, select "Yes" in "Download Enable" option, then input the Download URL directly,
you can use absolute path like
"http://www.flipbuilder.com/flip-pdf/example/files/download/FlipPDFDemo.pdf" or relative
path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the PDF to the
same path).

Then readers can click the icon n to download your uploaded PDF file directly.

(7) Full Screen
To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen
Button" option: Full Screen Button Shaw

[
. . .ﬂ . . . . . . " n
Then you can click icon to view flipbook in Full Screen, click icon or "Esc

button to exit from the Full Screen.
Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode,
you can set "No" in "Full Screen without Tool Bar" (just in Classical Template):

Full Screen Without Toal.. | Yes

Copyright 2010 by FlipBuilder.com
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ElHelp Config [
Help Button \Show
Help Content File |-type.png =]
Help Window Width 400
Help Window Height 450
Show Help At First Show

To show tips about viewing flipbook, you can set "Show" in "Help Button" option, and you
can define Help Content manually by inserting "Help Content File (image or SWF)", also
enable to define the Width and Height of the Help image or swf. If you set "Book->Retain the
book to center->No", you can set "Show Help At First->Show" to display the Help Panel with
the Book as below:

FLir PDF

Double-click to zoom infroom out;
Drag the page corner or
Use mouse wheel to flip pages.

You can also click the button to view the same Help page in pop-up window.

(9) Social Share

If you want your flipbook viewers to send the link to their friends or clients via Facebook,
Twitter, Linkedin, Google, Yahoo and so on, you can add a Social Share button in your
flipbook for readers to send out your flipbook link immediately:

| SocalShareButton _[show

The readers just need to click the "Social Share" button ﬁ, then the below window will pop

Copyright 2010 by FlipBuilder.com
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up for them to choose share channel:

Social Share

Microsoft Word - demo3.doox

[] Facebook
in Linkedin

B _Delicio.us

2 Technorati

Link: (el ipbuilder.com/flip-pdf/example/

™ Twitter
Google

RELT

E-\—?‘ StumblelUpon
) ek

m Mix

+ More

(10) Share Button

If you want readers to share via Email, you can enable "Share" feature as below shows:

Hshare Button
Share Button Show
Email Subject Rear my fii...
Email Body {link

When the viewers click the share button E, they will enter into the Email interface with

the link of your flipbook in the Email body.

(11) Home Button

Button

You can add a home buttonﬂ to help reader to click and go to your website directly:

(12) Auto Flip

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the

Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times

of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip

button “, the flipbooks will be flipped by staying 3 seconds per page); if you want to

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes":

R il

||;|wher| giﬁrtup B e

(13) Tool Bar on Top (only in Float Template)

If you want to place the toolbar in Float templates on the top of the flash eBook, you can set

"Tool Bar on Top" as "True":

Copyright 2010 by FlipBuilder.com
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[ Tool Bar on top [True |

(14) Page Number Box on Bottom (only in Float Template)

| Page Mumber Box On B... [True |

5. Initial Show (set in Float/ Spread Template)

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just
select "Bookmark" or "Thumbnails" in this option:

— ) g
For Example, select "Thumbnails": [ It Show |Thumbna||sj

Then you will get flipbook shown with below initial interface:

FLip PDF

6. Bookmark

| ElBackmark |
Font color | IMCw000000
Background color 00 SEAFF e
Background sipha |1
Always Show Bockmark | True
Fanis Position Left

FLip PDF

In "Design Setting" panel (only in Classical Template, in other templates, the colors will be
adjusted automatically based on your defined flash window color), you can set "Font color",
"Background color", "Background alpha" (refers to the background opacity, value interval:

Copyright 2010 by FlipBuilder.com
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0~1, "0" stands for the background is totally transparent), "Always Show Bookmark->True/
False" and "Panel Position->Left/ Right".

In "Bookmark" panel, if you didn't check "Import bookmark" option in "Import PDF"
interface, or you want to create new bookmarks for your flipbook, you can add bookmarks
even sub-bookmarks here, click "Add" icons and then input "Title" and "Page".

When click the bookmark button , it will popup the bookmark panel immediately, and

click on those bookmarks, it will jump to the defined page automatically

7. Links

FLip PDF PRO

BlLinks
Mouse over color
Link alpha o
Open Window Blank
Enable after zoomingin  |Enable

Create your professional fipping book with POF files

If you have check "Import links" option in "Import PDF" interface, or add links in "Edit Page"
interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers
to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent),
and "Open Window->Blank/ Self". The links also can be clicked after zooming by setting
"Enable after Zooming in->Enable".

8. Language

| Language Endglish -|

You can set language for showing tools or tips in your created flipbook, and here is the
specialized instruction page for setting the "Language Option".

9. Security Settings

| Security Settings Single Pass |

If you want to protect your flash books with passwords, you can click "..." icon to enter into

Copyright 2010 by FlipBuilder.com
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"Flash Security Config" interface:

oy

G e Security

Hote:
Srgls Passveord option mesns Shat usens need the nassvwerd to view the fash book.

Exclude Front Pages option ks & st 2 page number, all Latier pages can't be
viewed without mputtng passward.

Secunty Type
o Seaurity
( y
N
L & Single Passwond: 123458
Pratect Fage Range
Al Pages
@ Exdude Front Pages o

= [Co=

Select "Security Type->Single Password", and input passwords into the box (there is no

restriction on password format at present). You can also set "Protect Page Range" as "All

Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4

algorithm to protect eBook pages, the eBook content pages will show nothing without

permission.)

10. Font

Search Result Font Color | []0xCFF1FC

Search Result Font

Q. Search

Font Color
Button Font
|Window Font Color

WindowFont
Bookmark Font Color
Bookmark Font IC3 | Page3 programming tricks need!

| @Arial Unicode MS

x

Product features program O\
Pag A o

PageZ: any programming work

PageS:program to convert unlimited PDF

files to to

Page6:any programming work

If you want to change fonts of toolbar buttons, flash windows even bookmarks or search

panel, you can set font types and colors in Font Panel.

11. Google Analytics

Google Anaiyﬁcs ID

In the HTML output format, you can add statistics by using google analytics. You can get

more information about Google Analytics ID from http://www.google.com/analytics/ .
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12. Start Page Numbering

If you don't want to count in the cover page, table of contents pages into the actual page
numbers, you can set "Start Page Numbering" as the number you want to start to number from.
For example, you set "Start Page Numbering->5", then you will get page number box like below:

- Start Page Mumbering 5 Pages: 1{5/8) I

13. Minime Style

If you want to present Page-flipping eBook pages directly without showing toolbar, especially
when you want to embed eBook into a small area in existing webpages, then you can use this

"Minime Style":
Minime Style
Use Minime Style ‘fes
Width 400

Height 300

The Minime Style will trigger when the Width or Height of the Flash Container is less than the
defined value. You can also always show the page-flipping eBook in Minime Style with adding a

parameter to your URL like this: www.yourdomain.com/index.html?alwaysMinimeStyle=true .

14. Export Theme

If you want to save the current template settings as your own style template for later uses,
you can click "File->Export current settings as Theme" button to storing all current template
settings, include the background images, margin values, toolbar buttons and so on. Then
when you want to use later, just click "File->Import Themes", the theme will be added to the
templates selecting interface.

. u Apply Change . .
At last, click T jcon to apply the settings.
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IV. Language Options Interface

Click "Option->Flash Language", you will enter into the Language Settings interface as below
shows:

| I Language Settings ﬂ

s
You can new or edit a language for the flash flipping book.
The Labled column below s the string that will be displayed in the flash.
w The language will be st in the flash template settings
Language Nome:  [Chinese v) [ entonguage| [ Kpsete | (B sovees..] [ SGiosd.. |
Language Settings
Label Labled - [ [Eedt
First Button B |
Next Page Sutton T—m =
Last Button RE—&E |
Previous Page Button Hi—m
Downioad Button T#
Print Button $TEN
search Button B
Book Mark Button B
Help Button EeEh
Enable FulScreen Button 28
Disable FullSoreen Button =R
vt M Dby T X
Lo ] [Lgee |

Panel Description:

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books
in defined language, and the program provides you five different languages for you to use:
English, Chinese Arabic, French and Greek.

Language Mame: [Eﬂghsh ’]
Arabic
Chinese
Cf ll
French
Greek

You can also add other language for your own uses:

-~
1. Click the button [ - bew La”g”age] and define name for the new language:

"I New Language EETN
Mew Language |
fiame: French
Copy From: (Engeh 3]
[ ]

Click "OK" to save the new language in the list;
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2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box,
then click "Save And Edit Next":

Language Settings

Kext Page Butbon

Last Button Last i Edti Language Item
Priévions P Button (i Y | e ——
Download ﬁtm Dowricad || EAtLanguage String |
Frint Button Print

Search Butten Seareh Lebel:  First Button
Bock Mark Bution Besak Mark

Halp Button Help |beled;  Preswbre|
Enable FulSaraen Buttan Eniabis Fulls

Misahls Fullsresn Button  Désabla Fudd

L ] ey B stbeyey

[ gzﬁnélfd&ﬂut l!

o

o]

3. At last, you can get all Labels translated into your new language as the images shows:

Label

First Button

Mext Page Button

Last Button

Previous Page Button
Download Button

Print Button

Search Button

Book Mark Button

Help Button

Enable FullScreen Button

Disable FullScreen Button
Zovind Fin Bridtan

Labled

Premigre

Page suivante
Dernigre

Page précédente
Telécharger
Imprimer
Rechercher
Réservez Mark
Aide

Activer FullScreen

Desactiver FullScreen
i B wried

Delete
You can delete unwanted language:

Or save your edited new language file as XML or TXT file:

33 Load...
Load language file saving before for current using:
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V. Output Interface

:,i. QOutput Option @

Jutput |
Qutput type

@ = oL @ =, L. &=
:3’ @ *.html I:J%! O Fexe i ) *.app

[¥] Also Make Mobile Version  Make output page-flipping eBook waorks on iPad, iPhone and Android mohile devices

Path
Qutput Folder: C:\Jsers\Administrator\Desktop
File Name: index hitml
Options
HTML Title: Microsoft Word - demo3.docx
[E1Bumn to co

ter |0;1:0,G: PLDS ~ DVD-ROM DH-16D55 VD15

Make it automatically play the fipbook in CD

Cancel I I LConvert

Output types:

1. HTML

.;% @ = html

This output type is for uploading created page-flipping ebook onto websites. You can define
HTML Title and other properties by clicking "Advanced" button:

Options

HTML Title: demno

Set Keywords, Description or even Script in the below interface:

1§ Advanced Settings E

HTML Advanced Settings

HTML Meta Settings

Title: demo

Keywords:  pdf, flipbook, page-fipping, ebook, onine, website, flash, background, music

Deseription:  his page-fioping eBook shows you the stunning flash effect on PDF pages, a

Add Saripts

You can put some tracking
code such as Google
Analytics here,

Need dosed <script>tag!

I
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2.ZIP

EE ®-=z

~Fm

This output type is for compressing the created files into an integral ZIP package which can
be sending out as attachment directly. You can also define HTML Advanced Settings by
clicking "Advanced" icon. Your recipients just need to uncompress the ZIP file and then they
can view the HTML flipbook instantly:

, files

\F__;I:Iemu.html

book.swf

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:
rm— -
==’
demo.exe

You can also define Icon and Opening Window Size in Advanced Settings:

5 Aduvanced Settings e

Exe Advanced Settings

Exe Window Info

Caption; dema
e 1
S | | pefaar |
Window Size Opbion

Maomized Custom Size

@ Full Soreen

If you want to make executable application to run on Mac devices, you can output as
"* app" format.
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5. Mobile Version

[¥] Also Make Maobile Version
You can even output Mobile Version while choosing HTML or ZIP format at the same time.
After creating mobile versions, you just need to output all files online (including HTML, SWF,

"files" and "mobile" folders), then you can visit the flipbook page through your mobile
browser.

6. Burnto CD

[ Burn to €D

CD Writer |0:1:0,G: PLDS  DVD-ROM DH-16D55 VD15 =

Disc title: PageFlipping eBook

[¥] Make it automatically play the flipbook in CD

After choosing output type, then check the option "Burn to CD", set "CD Writer", define
"Disc title".

About "How to make created eBooks available for others online", you can view details in
below support page:
http://flipbuilder.com/support/how-can-i-share-my-created-ebook-online.htm .

At last click |Ebutton to output flipbook in your
defined type.
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VI. Batch Convert Interface

1 Add PDF Documents

||| A Add Files |/ Add Folder ¢ Clear Al
Name Path
_-Flip PDF E:\Useful Documents\POFs'Flip PDF.pdf
A=Flip Word E:\Useful Documents\PDFs'Fip Word, pdf
| A+Flip PPT E:\Useful Documents\PDFs\Fip PPT.pdf
2 Settings
utput Se ngs’—'ff PDF Settings

QOutput type

3 @ =html D *.2p r‘_“% @ *exe i. @ *.app

[#] Also Make Mobile Version Make output page-flipping eBook works on iPad, iPhone and Android mobile devices

Path
Qutput Folder; C:\Users\Administrator\Desktop\fipbaok Browse. .. Open
File Mame: {PDF FileName} .
Flip PDF
Options
HTML Title: My FlipBook - {5 Advanced
My FlipBook

[T Merge All FDF Files to One FlipBook

| @ converttoFlash

]:I: Convert to Flash

1. Add PDF Documents
,_Q";, Add Files |

Click this icon to add PDF files from computer;

| e Al E°|der.| Click this icon to add all PDF files in the folder (include sub-folders).

You can also remove some unwanted PDF, move up/ down files, or clear all documents.

x Remove %f Clear Al @ Maove Up @' Maove Down

2. Settings
(1). Output Settings

i. Choose Output Type

Quiput type

@ oo

»

[¥] Also Make Mobile Version Make output page-fiipping eBook works on iPad, iPhone and Android mobile devices
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ii. Choose Output Path
Path

Qutput Folder: C:\Users\Administrator\Desktop [ Browse... J[ Qpen I

You can also define output name pattern with FileName, Title, Subject and so on:

File Name: Iz

{PDF Title}
{PDF Subject}

EEDF .ﬁ.uﬂmri
POF FileName

And after defining the File Name, you can preview the result example below:

File Mame: {PCF FileMame} Flipping Book

Flip POF Flipping Book

iii. Define Output Option

Options

Caption:  {POF FileMame} - 3¢ Advanced

Flip POF

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon,
Window Size for EXE flipbooks:

1 Advanced Settings ﬁ | Advanced Settings M
HTML Advanced Settngs | [(Eve advanced Settngs 1
HTML Mats Sattings Exe Window Info
Tide: demo Caption:
Kewywords:  pdf, fiobook, page-fiopng, ebook, orine, website, fach, badground, music _ : z
AR, Toon: :—B we | | Defaut |
Reserption: s page-fipping eBook shows you the stumning flash effect on POF pages, & L j ==
Add Sopts Windlw Size Coben
Wou £an put some radang [etanomeed Cystom Size
code such 5 Godgle
Analytcs here.
Need dosed <sapt >tag! @ Bl Socen
| ” — Wl = E
| L] [coms Coc ) [ome ]
= -

iv. Merge All PDF Files to One Flip Book

[¥]iMerge All FOF Files to One FlipBook:

(2). PDF Settings

i. Page Range
The Page Ranges to Import
(™) All pages

2-5 Example:1,3-21,30

You can convert "All pages" or just "Custom range";
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ii. Watermark

Watermark

(1.4 Place a custom text or image
‘499' Watermark{Stamp) to the file(s)

Click "Set Watermark" icon to enter into "Watermark" interface:

Option - ==
Watermark -
] Applying Watermark
Watermark Name Type A
Eaf
[C] A Text -FrraaL Text -

[C] A Text - coMPLETED Text [t
[F] A Text-DRAFT Text
| T A Text -FOR PUBLIC RELEASE Text & [
M [E] A Text - INFORMATION ONLY Text = I
[T A Text - NOT FOR PUBLIC RELEASE Text .
[C1 A Text - nOT APPROVED Text (3 3% W
N [C] A Text - Company(Tie) Text b l
[C] A Text -LOGO eft-top) Text & | |
[C1 A Text -LOGO (Right-Top) Text |
] A Text -LOGO (Left-Bottom) Text -
|1 A Text -LOGO (Right-Bottom) Text
[] A Text -Dynamic - (title) Text
i [] = tmage - LOGO image -
3 Lo | [ conce

Check "Applying Watermark" option, then you can choose default stamps, Edit them, or Add
Text Watermark, Add Image Watermark, Delete, Move Down/ Up.

iii. Page Quality

L LIGlIL Y
Medium guality medium file size
Low guality small file size
Lower guality smaller file size

Choose quality and size type from listed five kinds.

##iv. Other Options#

O s ebiackinonk: | o your PDF file contains bookmarks, check this option to use in output

page-flipping eBook;

V] mport finks If your PDF file has links, check this to enable in flipbook;

V] Enable search Check this option to enable search functionality in created flipbook.
3. Convert

S

FJ Convert to Flash

Click icon to batch convert listed files together.
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License Agreements

All copyrights to Flip PDF (the Software) are exclusively owned by FlipBuilder.com. For more
information, visit our website at www.Flipbuilder.com .

Anyone may use this software but all the page-flipping eBooks generated will automatically
have a demo watermark on the first page of them. To remove the limitation you must
register.

Once registered, the user is granted a non-exclusive license to use the Software on one
computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased,
but may be permanently transferred, if the person receiving it agrees to terms of this
license.

The Software unregistered (trial) version may be freely distributed, provided the distribution
package is not modified. No person or company may charge a fee for the distribution of the
Software without written permission from the copyright holder.

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble,
otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed
Software, except as provided for in this agreement. Any such unauthorized use shall result in
immediate and automatic termination of this license and may result in criminal and/or civil
prosecution.

All rights not expressly granted here are reserved by A-PDF Solution.

Installing and using the Software signifies acceptance of these terms and conditions of the
license.

If you do not agree with the terms of this license you must remove the Software files from
your storage devices and cease to use the product.
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How to Order

Order Online (http://www.flipbuilder.com/flip-pdf/index.html) or Order Toll Free
1-877-353-7297 (When you order toll free just give the operator the product number of the

product you would like).

How to purchase online?

1. Select a license type above, and click [Buy Now]

2. Select the currency that you want to use. (You can also continue shopping)

3. Fill billing information and select a payment method. (Your information is safe with us)
4. Check the information you filled previously and click "Place Secure Order"

Other Order Ways—With Phone/Mail/Fax/Check:

If you are not comfortable ordering online witha credit card, you are welcome to choose an
offline order option in the payment section of the order process. We accept mail, fax, wire,
and PO (if applicable) ordering options in addition to ordering online. We also provide
phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for
International Callers.

Please note that all of the offline ordering options do have additional fees for processing. To
place an order by mail, fax, wire, and PO (when applicable), use the online form and then
choose one of these payment options found in the Payment Method section of the form.
Once submitted online, the appropriate information will be provided to you in your web
browser to send your payment to us offline.

100% unconditional 30 Day Money Back Guarantee

Want to custom the program or have other questions about purchase?
Contact us at alice@flipbuilder.com .
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Support

You can easily search or browse our frequently asked questions, and learn tutorials about
products, and get your registration code back. If you don't get a satisfying solution, please
contact support team for help.

1. Frequently Asked Questions
You can find answers to questions about technique issues here:
http://www.flipbuilder.com/support/list-Flip-PDF

2. Learn tutorial about Flip PDF

We publish a video tutorial which shows you the easy procedure of dealing with Flip PDF, you
can view this video to quickly handle the stunning tool:
http://www.flipbuilder.com/demo/flip _pdf.swf

3. Get lost license code
Click here to look up the order » (http://www.regnow.com/cs/orderStatus)

You can pull up a copy of your order by entering your email address. After you find your
order, you may view its status, view details of your order (including the license key), and
obtain the invoice.

4. Contact Us
If you have other questions or requirements, contact us directly through our support Email:
alice@flipbuilder.com, we will respond you ASAP.
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